Geology 3210	

[bookmark: _GoBack]Lab: Introduction to GIS on Amity Creek

Last week, we went out to Amity Creek, where a number of slope failures have been contributing to sedimentation problems in the creek.  Slope failures of this type are not unusual in streams along the North Shore where they are downcutting through glacial tills and glaciolacustrine sediments.  However, they add a lot of suspended sediment to the river, and this fine-grained sediment can have deleterious effects on the local aquatic ecosystem.  

The last bend we looked at underwent bank stabilization treatment about four years ago in an effort to lower the fine-sediment load of Amity Creek.  We will investigate this bend historically through the use of historic air photos.  To spatially organize our data, we will be working in ArcGIS.  This lab is also set up to provide an introduction to GIS for those who are not familiar with the program.  

The goals of this lab are
1) Gain familiarity with ArcGIS, including how to open files and change the display.
2) Learn how to create shapefiles by importing data files and by digitizing on screen.
3) Make measurements of channel mobility in the study reach and estimate the role of meander migration of sediment loading
4) Learn how to export maps from ArcGIS
5) Learn how to create hillshades and 3D images in ArcGIS.  

What you will turn in (one report per person):
1. Digital pdf file of Amity Creek showing the locations of all slide failures mapped by the geomorphology class.  Post to Moodle assignment.  
2. Digital pdf file of your map of the study bend showing the location of the channel in 1939, 1972, 1991, and 2003.  Post to Moodle assignment. 
3. Digital pdf file of your map of Amity Creek with topography.  Post to Moodle. 
4. Answers to the bolded questions sprinkled through the text. 

Part 1: Getting started, and ArcGIS 101

First, pull out a flash drive, stick it in the computer, and make a folder for this project.  You will save all files here.  

Next, download the data you need from our Moodle site.  I have zipped all the files together there in a file called “Lab 5 Data”.  Save these files to your flash drive in a single folder. 

Open up ArcMap.  

The most recent, widely available air photos are from 2003.  Let’s start by adding this to our project.  Go to “File  Add Data  Add Data”.  You can also use the diamond with a plus sign button to add data: [image: ].

Navigate to your  folder with the data in it and find “2003_airphoto.tif”.  If your drive does not appear, click on the map network drive button in your dialog box: [image: ]  .  Add the drive and then find your folder.  Click on it once, and click on “Add” at the bottom of the box.  A photo of the eastern edge of Duluth should appear.  The main rivers are Lester River (on the east) and Amity Creek (on the west). 

To navigate in ArcMap, you can use the zoom in, zoom out, and pan (hand) buttons on the toolbar: [image: ].  Go ahead and look around the photo some.  Follow Amity Creek up and see if you can find where it goes around the backside of Hawks Ridge and where it splits into the east and west branches.  

Raster vs. Vector Data
There are two kinds of data that ArcGIS uses: raster and vector data.  Raster data are gridded, with points equally spaced apart (like the pixels on a digital photo).  Vector data are in the form of points, lines, or polygons.  The airphotos are raster data.  Line, point, and polygon data are vector data.  Always make sure the vector data files are listed above the raster files in the column on the left-hand side of the screen.  Then they will display on top of the raster data and you can see both of them.  You can also click individual layers on and off to make them visible and invisible and you can change the symbols used to display the vector data. 

Importing GPS data

To practice importing data, we will use data collected last week by you and your classmates.  They were given the task of mapping in the locations of all slope failures along the length of the river.  All of the GPS coordinates are collated in a file called Amity_Creek_UTM.xlsx.  

We need to convert an Excel File into a Table file.  Luckily, there is a tool for this job.  Open up the Toolbox by clicking on the icon that looks like this: [image: ].  Navigate to  Conversion Tools  Excel  Excel to Table.  Click on that tool.  For input file, select your Excel file (Amity_Creek_UTM.xlsx).  Give the output file a name and location (make sure there are no spaces in your folders or your file name).  For “Sheet”, select the Sheet named “Data”.  This is referring to the worksheet name in the Excel file.  This tool will turn your Excel data into a “Table”.  

To add the Table to your Arc project as a shapefile, you will need to import it.  Go under “File Add Data   Add XY Data”.  Navigate to your Table.  Make sure the X Field is set to “x” and the Y Field is set to “y”.  Check the coordinate system.  We measured our data in UTM coordinates, NAD 83, Zone 15.  If the listed coordinate system is not correct, then click on “Edit…”  Click on “Select”.  Open the folder for “Projected Coordinate Systems”  Open the folder for “UTM”.  Open the folder for “NAD 83”.  Select the “Zone 15N” version and click on “Add”.  Click on Ok, Ok, Ok until your data appear on the screen.  Are they in the right place?  

Working with vector data

The class data are part of a point shapefile.  This shapefile has an “attribute table” that includes the length and height of each failure you mapped.  Let’s color (or size) code each slope failure by area.  To do this, we need to first calculate the area of each slope. 

Start by taking a look at the list of data and their attributes.  You can find data attributes by right-clicking on the name of the new shapefile on the left hand side of the screen and selecting “Open Attribute Table”.  A table of data should appear.  To calculate the area, we need to first create a new column in our data table for area.  At the top of the attributes table is an icon that looks like a list [image: ] .  Click on the arrow and select “Add Field”.  Name the new field “Area” and make it type “integer”.  

Next, highlight the new column you made by clicking on the heading “Area”, and right-click.  Select “Field calculator” and ignore the error message.  In the field calculator, you’ll see at the bottom there is a blank box where you will type the equation.  Above the box it says “Area=”.  Double click on “length” under "Fields: ", click on the * sign, and then double-click “height”.  Click ok.  It should carry out your calculation and spit out the Area of each slope failure.  

Now we want to color/size code them.  Double click on the new shapefile’s name.  Open the tab labeled “Symbology”.  This is where you control how different files are displayed (color, pattern, etc.).  Right now it’s set to Single Symbol, so everything in the file has the same color dot.  Select instead “quantities” (on the left) and then “Graduated symbols”.  Under value field, it will list the attribute you want your color coding to be based on.  You want to select “Area”.  This will scale the symbol to the area of the slope failure.  Try other options and see if they work better (or not).  

If you like the color and symbol combinations, click ok.  If you want to change them, just double-click on each symbol and change the size, shape, color, etc. Then click ok on the main screen.  Now you have all of the slope failures mapped and coded according to size.  

Do some math
Let’s pretend that all of these slides occurred during the June 2012 flood.  We want to know what volume of sediment was eroded then.  Grant Neitzel did some detailed scanning of 8 bluffs before and after the flood.  He found that, on average, they eroded back 41 cm.  If you know the area covered by the failures, and you multiply it by the distance they eroded, you can get an estimate of the volume eroded.  Luckily, you have the areas from your survey.  We can use Arc to sum them up.  In the attribute table for your slump inventory, right-click on your newly created “Area” field.  Select “Statistics”.  Viola, you have a summed up area.

What is your estimate of the volume eroded from slides during the June 2012 flood on this part of Amity Creek?  







What additional data would you need to make this estimate more accurate?






Creating a map to display your data

We now want to create a map to highlight where the slope failures are located.  Not surprisingly, ArcGIS is set up for this.

First, set up your layers to highlight the ones you want to display on your map.  (Turn layers on and off).  Then zoom to the extent you want to view in your map.  

Once you have the right data layers visible, go to “View Layout View”.  This will set up the display to look like a mapsheet.  All good maps have some key ingredients: a title, a legend, a scale bar, and a north arrow.  You can add these by looking under the “Insert” menu.  Go ahead and add them to your map.  Play around with the options and ask questions if you are having trouble.  This map should look similar, but not exactly the same, as the map I gave you last week.  Now you can do it on your own. 

After you finish your map, you should export it (File  Export Map) as a PDF file.  Then upload it to the Moodle site.  

Saving your project:
Finally, you should save your project file.  Go under “File  Save As” and save your project to your flash drive.  The project file only saves the view and links to all of the required data layers.  If you want to take the data layers with you, you need to copy them to your USB drive.  To move files around, open ArcCatalog.  Within ArcCatalog, you can move, rename, create, and delete files without messing up internal links within ArcGIS.  If you do this, then you can open up your project file on another computer and everything, including all of the data files, will all be there. 

Part 2: Tracking changes through time

The rest of the lab will focus on tracking changes in a meander bend through time, using historic air photos.  

Historical air photos are a great source of data.  In MN, you can usually find photos back to the 1930s.  We have photos of Amity Creek from 1939, 1972, 1991, and 2003.  You can import them by using the “Add Data” button to add 1939photo, 1972photo, and 1991photo (you already have the 2003 photo).  

When these photos were obtained, they were scanned in and then georeferenced to place them into the correct spatial reference frame so that we can compare them through time.   How does georeferencing work?  You select a bunch of control points (usually things like bridges, road crossings, houses, etc.) that exist in a photo that is already referenced and one that is not.  These control points are used to determine how to shift, rotate, or warp the second image so that it lines up with the first spatially.  These photos were georeferenced to get the best fit right around the bends on the east branch of Amity Creek, but it still has problems (note, there are almost no good control points in the area).  In addition, by focusing on this specific area, the georeferencing elsewhere in the photos is even worse. 

As you look at the photos, you may notice that they are of varying quality, and it’s hard to see the banks sometimes.  Heck, it’s hard to see the channel sometimes.  To help you out, I mapped in the channel from 1939, 1972, and 1991.  You can add these files to your map. Click on the “Add Data” button and add “Channel1939”, “Channel1972”, and “Channel1991”.  

Find the confluence between the east and west branches of Amity Creek – ASK ME IF YOU DON'T KNOW WHERE TO GO!  I want to make sure everyone is in the right place.  You need to map in the channel from 2003 from the confluence up to the power lines.  Here’s how:

2A. Creating a shapefile and on-screen digitizing:

The easiest place to create a new shapefile is in ArcCatalog, which is the file management system for ArcGIS.  See if you can find a button that looks like a little yellow file cabinet with an open drawer: [image: ].  Click on it.  Navigate to the AmityCreek folder.  Click on it so that the contents are displayed in the right-hand side of the window.  Right-click in the right-hand side window and select New  Shapefile.  Give it a name.  Change the feature type to “polyline” (for a line shapefile) and set the coordinate system the same way you set it for the XY Data.

To add this new file to your project, click on the Add Data button and add the new file.  It should be blank.
To edit it, look on the toolbar and find “Editor” ([image: ]).  Select “Editor  Start editing”.  When prompted, click the layer you want to edit (your new file) and click ok. On the right side, your  file should appear under a Create Features box. Click on your layer. Editing is now turned on.  You can grab the little pencil and start drawing in lines by clicking on the screen.  Double click to end the line.  If you mess up, just select the line (or an individual vertex) and hit delete.   

When you are done drawing in your line, make sure you save your edits.  Under the “Editor” pull down menu, select “Save Edits”.  Then, in the same menu, select “Stop Editing”.  You now have a new shapefile.


Draw a sketch (below) of the area between the confluence and the power lines, with the channel in 1939 and 2003.  Indicate with arrows which way each bend has been migrating through time.   Is the georeferencing good enough to tell on all of the bends?








2B. Quantifying changes through time

Take a look at most downstream bend in this reach on the east branch (ask me if you want to clarify which one).  This is the downstream one that was recently stabilized.  
Which direction is (or rather, was) it migrating? 


 
We want to put some numbers on the rate of change.  You can use the measuring tool to figure out how far the channel has migrated.  The measuring tool looks like a little ruler with two arrows: [image: ].  Click on it.  Click on the start and end of the distance you want to measure.  The result will display in the box.  Double click to start a new line.  

How far did the channel move between 1939 and 2003 in the vicinity of this bend?  



What is the rate of movement?  (rate = distance/time)



What was the distance and rate of movement from 1939 to 1972?



1972 to 1991? 



1991 to 2003?



Did the rate change?  



If so, is the meander migration rate speeding up or slowing down?



Channels migrate back and forth across their floodplains.  The channel at this reach is now migrating into the valley wall rather than just reworking old floodplain deposits.  

Figure out the area eroded between 1939 and 2003.  You can do this by selecting the polygon option on your measuring tool (looks like a white trapezoid): [image: ].  Now you can click around the area of interest.  The measuring box output will now tell you the area and perimeter of your box.  


What is the area that has been eroded?



If the channel was migrating into a valley wall 5 meters high that entire time, then what is the volume eroded?



Over what time period?



What is the volumetric rate of erosion?  (Volume/time)



If the channel was instead migrating into a 1 meter high bank in a floodplain, then what was the volume eroded between 1939 and 2003?  





A typical georeferencing error for photos at this scale is ± 5 m.  
How does the georeferencing error compare with the measured migration distance?  Is the error greater or less than the measured change?  




Think back to the gravel bar you walked over after we crossed the creek.  It was really angular gravel, which implies it had not been transported very far.  Let’s figure out how much gravel likely came out of this eroding bend between 1939 and 2003.  To do this, we need to know what % of the eroded material was gravel-sized.  

Try out two scenarios:
Scenario 1: All of the material eroded between 1939 and 2003 was 5 m high till (use that volume).  Approximately 25% of the material in the till is gravel.  What volume of gravel was liberated through channel migration on this bend between 1939 and 2003?




Scenario 2: All of the material eroded between 1939 and 2003 was 1 m high floodplain.  50% of this material is gravel.  What volume of gravel was liberated through channel migration on this bend between 1939 and 2003? 




If this coarse material was moved downstream and deposited on the bar at the confluence, how thick of a layer would it make?  
Scenario 1:


Scenario 2: 



(Estimate the area of the bar top and spread the volume of coarse sediment over that area: Thickness = Volume/Area)  Show your work!

Creating a map to display your data
Using the directions above, create a map of this site, showing the 2003 map in the back and the traces of historic channels overlain on top.  After you finish your map, you should export your map (File  Export Map) as a PDF file and post it to Moodle.  

Part 3: Working with raster data:
One of the great things you can do in a GIS system is analyze topography over a large area.  Digital Elevation Models (DEMs) are now available for most of the world and even for Mars at a reasonably good resolution.  

Add the data file “DEM_10m_83” to your map.  

This is the DEM covering our study area.  You can monkey with the shadeset by double clicking on the name and finding the “Symbology” link.  Pick a different color ramp, or stick to grayscale if you want.

To help visualize topography better, people often create a hillshade map of their DEM.  This is a representation of the topography that is created by adding in shadows from a given direction.  

To create a hillshade map, first turn on Spatial Analyst.  You can do this by going to “Tools  Extensions”.  Make sure the box next to “Spatial Analyst” is on.  Go ahead and turn on “3D Analyst”, too.  

Ok, now open the toolbox. Click on the toolbox icon: [image: ] and open the Spatial Analyst Tools tab. Click Surface  Hillshade.  In the input, make sure “AmityDEM” is selected.  For now, the defaults should work ok.  Give the output raster a name (and make sure it’s going to the class folder) and click ok.  The azimuth and altitude are set to defaults of 315 and 45.  If you are trying to drape a photo over your hillshade (which we will do later), you may need to fiddle with these parameters some.  

Ok, so you have a hillshade.  Kind of neat, eh?  Let’s drape the DEM over it.  On the left-hand side of your screen, drag the DEM file up so it is listed before the hillshade map you just created.  Double-click on the DEM to bring up the display options.  Click on the “Display” tab and change the transparency to 60%.  Now you will see the hillshade with the DEM draped on top.  

You can also create a contour map from the DEM.  You can do this under “Spatial Analyst Tools Surface  Contour”.  (Make sure you are creating a contour map of the DEM, not of the Hillshade map.)  I’ll let you play with the settings.  

Create a nice map showing topography for the entire area where we mapped slope failures.  Save it as a pdf file and upload it to the Moodle site.  You can choose color scheme, contour interval, etc., but make sure you add a legend explaining it all (and a scale bar, north arrow, and title).  

Final Questions:
Many of these numbers are just estimates.  What are three things you could do to better refine these rates of erosion or deposition?











The bend we have been investigating was stabilized to lower sediment going into Amity Creek.  Do you think this bend was generating a lot of sediment in the context of the entire sediment budget of Amity Creek?  What information are you missing to make this judgment?  How much of that information can you either calculate, estimate, or measure directly?  (Don’t forget, you do have an inventory of all the slope failures on Amity Creek.)











Back-of-the-envelope bonus:  Estimate the % of the total sediment budget on Amity Creek that this one bank represents.  Use the data you collected last week to help you estimate the % contribution.  





Part 4:  Moving beyond 2 dimensions (optional, but pretty neat if you have time)

You can turn your view into a 3D image with an air photo draped on top.  To do this, you will need to open ArcScene. Click Customize -> Toolbars and make sure 3D Analyst is checked. ArcScene is on the 3D Analyst toolbar and looks like a circle with some buildings in it: [image: ].  In ArcScene, use Add Data to add the DEM file (DEM_10m_83) and the 2003 photo (or try the QuickBird 2003 photo).  Click the box next to the DEM file so that it is no longer visible.  Right-click on the photo file on the left-hand side and open up properties.  Select the “Base Heights” tab and select “Elevation from surfaces - Floating on a custom surface”.  Specify the DEM.  Click on the “Rendering” tab and set the quality enhancement to medium (high if the computer can handle it).  

Now go back to the properties  base heights tab and click on raster resolution.  Set the resolution to 10m.  This may take awhile, but it’s more accurate than the 120 m default resolution.  (Our DEM data are at 10 m resolution.)  Click ok.  See if you can find our site and follow the river downstream.  If it’s really slow, make the resolution a little higher. 

You can also add in vertical exaggeration if you want.  Under the base heights tab, change the offset at the bottom to be 3 or 10 or whatever vertical exaggeration you want. 
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with points equally spaced apart (like the pixels on a digital photo). Vector data are in theform
of points, lincs, or polygons. The airphotos are raster data. Line, point, and polygon dataare
vectordata. Alwaysmake sure thevector data files are listed above the rasterfiles in the column
on the left-hand side of the scrcen. Then they will display on top of the raster data and youcan
sceboth of them. Youcan also clickindividual layers on and off to make them visible and
invisible and you can change the symbols used to display the vector data.

Importing GPS data

To practice importing data, we will use data collected last week by you and your classmates.
They were given the task of mapping in the locations of all slope failures along the length of the
river. Thave collated all of the GPS coordinates intoa file Landslide_Data_2011.xlIsx. Itis
posted in the Amity folder on the Z: drive. Go find the file and copy it to your flash drive.

Toimport XY data, go under “File > Add Data > Add XY Data”. Navigateto your
spreadsheet. Double click on the Excel file, and select “xlnm#PrintArea”. Clickon “Add”. This
will open up a dialog box. Make sure the X Field is set to “xcoord” and the Y Field is set to
“yeoord”. Youwill need to specify a coordinate system. We measured ourpointsin UTM
coordinates, NAD 83, Zone 15. Clickon “Edit...” Clickon “Select”. Open the folder for
“Projected Coordinate Systems™ Open the folderfor “UTM”. Open the folder for “NAD 837,
Select the “Zone 15N” version andclickon “Add”. Click on Ok, Ok, Ok until your data appear
onthe screen. Are they in the right place?

[Note: If you everwant to import your own data, you just create columns for xcoord. yeoord, and
ID# (optional), sct printarca over your data, save it, and close the Excelfile. Thenyouare ready
toimport the datainto ArcGIS.]

Let’s first turn our XY table intoan official Shapefile, which s what ArcGIS calls its vector
datasets. Find the class data set in the list of data files on the left. Right-click on it and select
Data - Export Data... Giveitaname at the bottom and make sure it’s saving to your folder.
The other options should be set to the defaults “All Features” and “this layer’s source data”.
Clickok. When it asks if you want to add it to the map as  layer, say “Yes™.

Working with vector data
The class data are part of a point shapefile. This shapefile has an “attribute table” thatincludes

the lengthand height of cach failure youmapped. Let's color (or size) code cach slope failure by
arca. Todo this, we need to first calculate the arca of cach slope.

Cal

Start by takinga lookat the list of data and theirattributes. Youcan find data attributes by right-
clicking on the name of the new shapefile on the left hand side of the screen and seleeting “Open

| -|  Attribute Table”. A table of data should appear. To calculate the area, we need tofirst create a

new columnin our data tableforarca. At the top of the atiributes table is an icon that looks like a
st tab thatsays “Options™. Clickon it and select“Add Ficld”. Name the new ficld “Area” and
= makeit type “integer”.
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Creatinga. 1o dis ur data

Using the directions above, create a map of this site, showing the 2003 map in theback and the
traces of historic channels overlain on top. Afteryou finish your map, you should export your
‘map (File > Export Map) as a PDF file and post it to Moodle.

Part 3: Working with raster data:

One of the great things you can do in a GIS system is analyze topography overa large arca.
Digital Elevation Models (DEMs) are now available for most of the world and even for Mars at a
reasonably good resolution.

Add the data file “DEM_10m_83to yourmap.

‘This is the DEM covering our study arca. You can menkey with the shadeset by double clicking
on the name and finding the “Symbology” link. Picka different color ramp, or stickto grayscale
ifyou want.

To help visualize topography better, people often createa hillshade map of their DEM. Thisisa
representation of the topography that s created by adding in shadows from a given direction.

To create a hillshade map. first tum on Spatial Analyst. Youcan do this by going to “Tools >
Extensions”. Make sure the box nextto “Spatial Analyst” is on. Goahead and turnon “3D
Analyst”, too.

Change | Editing | Sign and
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Privacy
7

Ok, now open the toolbox: |find the Spatial Analyst. In the layer box, make sure “AmityDEM"

isselected. Next, under “Spatial Analyst = Surface Analysis® choose “Hillshade” Fornow, the
- defaults should work ok. Give the outputrastera name (and make sure it’s going to the class

folder) and clickok. The azimuthandaltitudeare set to defaults of 315 and 45. Ifyou are trying

to drape a photo over your hillshade (whichwe will do later), you may need to fiddle with these
-|  parameters some.

Ok, so you have a hillshade. Kind of neat, ch? Let’sdrape the DEM overit. On thelcft-hand

- side of yourscreen, drag the DEM fileup so it s listed before the hillshade map youjust created.
Double-click on the DEM to bring up the display options. Click on the “Display”tab and change
the transparency to 60%. Now you will sce the hillshade with the DEM draped on top.

You canalso create a contour map from the DEM. Youcan do this under “Spatial Analyst >
Sutface Analysis > Contour”. (Make sure youare creating a contour map of the DEM, not of
the Hillshade map.) T'll let you play with the scttings.

.| Createanice map showing topography for the entire area where we mapped slope failures.
Saveit as a pdf file and upload it to the Moodle site. You can choose color scheme, contour
interval, etc., but make sure youadd a legend explaining it all (and a scale bar, north arrow, and

O itle).
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